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*Net Employment Outlook results range from +100% to –100%

Executive 
Summary
40,413 employers across 42 
countries were asked about their first 
quarter hiring intentions and closing 
the gender gap in the latest edition 
of the ManpowerGroup Employment 
Outlook Survey.

25% Global Net Employment Outlook
Calculated by subtracting employers planning reductions 
vs. those planning to hire*. Unchanged since the previous 
quarter and decreased by 1 percentage point since Q1 2024.

30% of companies say they have 
already fully achieved gender equality, 
compared to 24% a year ago.

Highest Global Hiring Demand

Information 
Technology

Finance and 
Real Estate
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Q1 Employment 
Outlooks
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Global Employment 
Outlook for Q1 2025
Used internationally as a bellwether of 
labor market trends, the Net Employment 
Outlook – calculated by subtracting the 
percentage of employers who anticipate 
reductions to staffing levels from those 
who plan to hire – now stands at 25%.

Global Net
Employment
Outlook

25%

of employers anticipate 
an increase in hiring

anticipate a decrease

report no change

are unsure

41%

16%

40%

3%

4



Executive Summary Q1 Employment Outlooks Workforce Trends Industry Outlooks About the Survey

Global Outlooks have remained unchanged since the previous quarter and weakened slightly when compared to 
the same time last year, dropping 1 percentage point. 

Changes Over Time
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Hiring Expectations for January – March by Country

U.S. 34%
Mexico 32%
Costa Rica 31%
South Africa 31%
China 29%
The Netherlands 29%
Switzerland 29%
Belgium 28%
U.K. 28%
Brazil 27%
Norway 27%
Canada 26%
Guatemala 25%

India 40% Singapore 25%
Germany 24%
Ireland 24%
Finland 22%
France 21%
Colombia 20%

Portugal 20%
Italy 19%
Panama 19%
Spain 17%
Sweden 17%
Taiwan 17%

Peru 20%

Japan 15%
Poland 15%
Czech Republic 14%
Hungary 14%
Greece 12%
Puerto Rico 12%
Türkiye 12%
Australia 11%
Austria 10%
Romania 10%
Chile 9%
Israel 8%

Slovakia 16%

6

Argentina -1%
Hong Kong 6%

Seasonally Adjusted,
Net Employment
Outlooks (NEO)

25% Global
Average NEO

-1% Argentina
Weakest NEO

40% India
Strongest NEO
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Strongest and 
Weakest First 
Quarter Outlooks
With stable outlooks across 
the regions, employers in the 
North America (32%) region 
reported the strongest 
hiring intentions, followed by 
the Asia Pacific (27%), South 
and Central Americas (23%), 
and Europe, the Middle 
East, and Africa (19%).

Strongest

Weakest

India

40%
U.S.

34%
Mexico

32%

Argentina

-1%
Hong Kong

6%
Israel

8%
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Year-Over-Year Changes by Country

Italy +6%
Japan +5%
Hungary +4%
Norway +4%
India +3%
Ireland +3%
South Africa +3%
France +2%
Canada +1%
Israel +1%
U.K. +1%
Argentina +0%
Germany -1%

Czech Republic +6%
Global Average -1%
Slovakia -1%
U.S. -1%
Mexico -2%
Poland -2%
Spain -2%
Taiwan -2%
China -4%
Costa Rica -4%
Peru -4%
Singapore -4%
Sweden -4%
Switzerland -4%

Greece -1%
Brazil -5%
Romania -5%
Finland -6%
Panama -6%
Türkiye -6%
Guatemala -7%
The Netherlands -8%
Portugal -8%
Colombia -11%
Austria -16%
Australia -17%
Puerto Rico -21%
Hong Kong -23%

Belgium -5%Seasonally Adjusted,
Net Employment
Outlook Changes 
Since Q1 2024

+6% Czech Republic
Most Strengthened Outlook

-23% Hong Kong
Most Weakened Outlook

-1% Global
Global Average Outlook
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Most Significant Outlook Improvements for Q1
Employers in 12 countries report a stronger hiring outlook compared with the same period last year, weakening in 
28, and remaining unchanged in one.

Czech Republic

+6%
Italy

+6%
Japan

+5%
Norway

+4%

Quarter-Over-Quarter Improvements

Year-Over-Year Improvements

Hungary

+4%
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Japan

+3%
Czech Republic

+3%
India

+3%
Sweden

+3%
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Hiring Expectations by Company Size

12%

Less than 10 
Employees

22%

10 - 49 
Employees

25%

50 - 249 
Employees

31%

250 - 999 
Employees

29%

1,000 - 4,999 
Employees

28%

5,000+
Employees
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Global Employment Outlooks Across Key Industry Sectors
Businesses in the IT industry reported the brightest outlook, improving by two percentage points since the previous 
quarter and the same time last year.

37%
33%

27% 26% 24%
20%

15% 14%
10%

*Government or Public Service; Not for Profit/NGO/Charity/Religious organization; Other Industry; Other Transport, Logistics & Automobiles Sub-Industry; Educational Institutions; Agriculture & Fishing

Information 
Technology

Financials and
Real Estate

Energy and 
Utilities

Health Care 
and Life 
Sciences

Industrials and 
Materials

Transport, 
Logistics and

Automotive

Communication
Services

Consumer 
Goods and 

Services

Other* / None 
of the Above
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Employment Outlooks Across 
Europe, the Middle East, and Africa
Hiring expectations remain the lowest in Europe, the Middle 
East, and Africa (19%), and has weakened by 2 percentage 
points since Q4 2024 and 1 percentage point year-over-year.  

Outlooks vary across the region with employers most keen to hire in 
South Africa (31%).

The strongest Outlook globally for the Financials & Real Estate 
industry vertical was reported by employers in Belgium (53%, tied 
with employers in China). Consumer Goods and Services in The 
Netherlands (47%); Communication Services in Germany (45%); 
Energy and Utilities in Belgium and Finland (both 44%); and 
Industrials and Materials in Norway (41%).

Strongest Hiring Intentions

Weakest Hiring Intentions

South Africa

31%
The Netherlands

29%
Switzerland

29%

Israel

8%
Austria

10%
Romania

10%
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Strongest Hiring Intentions

Weakest Hiring Intentions

India

40%
China

29%

Hong Kong

6%

Australia

11%

Singapore

25%

Japan

15%

Employment Outlooks 
Across the Asia Pacific
Hiring managers across the Asia-Pacific countries anticipate 
the second strongest regional Outlook (27%), remaining 
unchanged from the previous quarter, but decreased by 3 
percentage points when compared to the same time last year. 

Employers in India (40%) continue to report the strongest 
Outlooks in the region, with most cautious in Hong Kong (6%). 

The strongest Outlook globally for the Transport, Logistics, 
and Automotive industry vertical was reported by employers in 
Singapore (67%). Employers in China reported the highest 
Outlooks for both Financials and Real Estate (53%, tied with 
employers in Belgium) and Healthcare and Life Sciences (47%).
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Employment Outlooks Across 
the Americas

Employers across North, Central, and South America reported 
the strongest regional Outlook for Q1 (29%), with hiring 
intentions improving 1 percentage point quarter-over-quarter 
but declining -3 percentage points from the same period last 
year.

Employers in the U.S. (34%) reported the strongest hiring intentions 
across the regions, with the weakest in Argentina (-1%).

The strongest Outlook globally for the Information Technology 
industry vertical was reported by employers in the U.S. (53%).

14

Mexico

32%
Costa Rica

31%

U.S.

34%

Strongest Hiring Intentions

Weakest Hiring Intentions

Argentina

-1%
Chile

9%
Puerto Rico

12%
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Workforce 
Trends
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Steady Gains in Gender Equality
Over the past year, more companies have made progress toward gender equality.

16

10%

23%

41%

24%

8%

19%

40%

30%

2024 20252024 20252024 20252024 2025

A long way from 
full equality

Still reasonably far 
from full equality

Getting close to 
full equality

Fully 
achieved
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More Companies Advancing Pay Equities 
Nearly 3 in 5 organizations (58%) report they are on track with their pay equity initiatives, improving 6% when 
compared to the same time last year.

17

58%

56%

Industrials 
& Materials

57%

Consumer Goods 
& Services

62%

Energy & 
Utilities

57%

Health Care & 
Life Sciences

63%

Information 
Technology

64%

Communication 
Services

59%

Transport, Logistics, 
& Automotive

60%

Financials & 
Real Estate
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Assessing Equitable Gender Recruitment & Retention Practices

To understand what's driving progress in gender equality in recruitment and retention, employers shared insights on 
the strategies and benefits that are producing results.

42%
40%
38%
36%
35%
35%
34%
34%
34%
34%
32%

Helping gender equality
Building trusting relationships with teams

Effectively supporting employee well-being

Implementing policies to ensure equal career development opportunities

Recognizing employees for fostering DEI efforts

Offering support for employees caring for children, or sick/elderly adults

Mentoring and training employees across different working models

Tracking promotion outcomes for employee programs

Proactively communicating with teams across different work models

Analyzing DEI challenges to find solutions

Measuring the use and impact of flexibility policies

Auditing DEI policies and programs

18
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Outlooks by 
Industry Vertical
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Communication Services
The global NEO for the Communications Services 
industry is 14%. This figure decreased since both the 
previous quarter and when compared to the same period 
last year by 2 and 16 percentage points, respectively.

30%

16%

11%

16%

14%

Q1 2024

Q2 2024

Q3 2024

Q4 2024

Q1 2025

DECREASED
YEAR OVER YEAR14%

Communication Services 
Net Employment Outlook:
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Consumer Goods 
and Services

The global NEO for the Consumer Goods & Services 
industry is 20%. This figure decreased since both the 
previous quarter and when compared to the same period 
last year by 5 and 2 percentage points, respectively.

22%

19%

22%

25%

20%

Q1 2024

Q2 2024

Q3 2024

Q4 2024

Q1 2025

DECREASED
YEAR OVER YEAR20%

Consumer Goods and Services
Net Employment Outlook:
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26%

18%

9%

8%

10%

Q1 2024

Q2 2024

Q3 2024

Q4 2024

Q1 2025

DECREASED
YEAR OVER YEAR10%

Energy & Utilities
Net Employment Outlook:

Energy & Utilities
The global NEO for the Energy & Utilities industry is 
10%. This figure increased since the previous quarter 
but decreased when compared to the same period last 
year by 2 and 16 percentage points, respectively.
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33%

29%

27%

32%

33%

Q1 2024

Q2 2024

Q3 2024

Q4 2024

Q1 2025

INCREASED
OR EQUAL

YEAR OVER YEAR33%
Financials & Real Estate
Net Employment Outlook:

Financials & Real Estate
The global NEO for the Financials & Real Estate industry 
is 33%. This figure increased by 1 percentage point since 
the previous quarter and remained unchanged when 
compared to the same period last year.
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27%

26%

27%

26%

27%

Q1 2024

Q2 2024

Q3 2024

Q4 2024

Q1 2025

INCREASED 
OR EQUAL

YEAR OVER YEAR27%
Healthcare & Life Sciences
Net Employment Outlook:

Healthcare & Life Sciences
The global NEO for the Healthcare & Life Sciences industry 
is 27%. This figure slightly increased by 1 percentage point 
since the previous quarter and remained unchanged when 
compared to the same period last year.
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26%

21%

24%

26%

26%

Q1 2024

Q2 2024

Q3 2024

Q4 2024

Q1 2025

INCREASED 
OR EQUAL

YEAR OVER YEAR26%
Industrials & Materials
Net Employment Outlook:

Industrials & Materials

25

The global NEO for the Industrials & Materials industry is 
26%. This figure remains unchanged when compared to 
both the previous quarter and the same period last year.
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35%

34%

29%

35%

37%

Q1 2024

Q2 2024

Q3 2024

Q4 2024

Q1 2025

INCREASED 
OR EQUAL

YEAR OVER YEAR37%
Information Technology
Net Employment Outlook:

Information Technology

26

The global NEO for the Information Technology industry 
is 37%. When compared to both the previous quarter 
and the same time last year, this figure has increased 
by 2 percentage points.
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Transport, Logistics
& Automotive

The global NEO for the Transport, Logistics, & Automotive 
industry is 24%. This figure has decreased when compared 
to both the previous quarter and the same period last year 
by 2 and 1 percentage points, respectively. 

25%

16%

21%

26%

24%

Q1 2024

Q2 2024

Q3 2024

Q4 2024

Q1 2025

DECREASED
YEAR OVER YEAR24%

Transport, Logistics & Automotive
Net Employment Outlook:
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About the 
Survey
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Forward-Looking Statements –
 This report contains forward-looking statements, 
including statements regarding labor demand in 
certain regions, countries and industries, economic 
uncertainty and workforce trends, including, trends 
related to gender equality and advancing pay 
equities. Actual events or results may differ materially 
from those contained in the forward-looking 
statements, due to risks, uncertainties and 
assumptions. These factors include those found in 
the Company's reports filed with the U.S. Securities 
and Exchange Commission (SEC), including the 
information under the heading "Risk Factors" in its 
Annual Report on Form 10-K for the year 
ended December 31, 2023, whose information is 
incorporated herein by reference. ManpowerGroup 
disclaims any obligation to update any forward-
looking or other statements in this release, except as 
required by law.

Unique – It is unparalleled in its size, scope, longevity and area of focus. The ManpowerGroup Employment Outlook 
Survey is the most extensive, forward-looking employment survey in the world, asking employers to forecast employment over 
the next quarter. In contrast, other surveys and studies focus on retrospective data to report on what occurred in the past.

Independent – The survey is conducted with a representative sample of employers from throughout the countries and 
territories in which it is conducted. The survey participants are not derived from ManpowerGroup’s customer base.

Robust – The survey is based on interviews with 40,413 public and private employers across 42 countries to measure 
anticipated employment trends each quarter. This sample allows for analysis to be performed across specific sectors and 
regions to provide more detailed information.

Focused – For more than six decades the survey has derived all of its information from a single question: “How do you 
anticipate total employment at your location to change in the three months to the end of March 2025 as compared to the 
current quarter?”

Survey Methodology – The methodology used to collect the data for the Employment Outlook has been digitized in 
42 markets for the Q1 2025 report. Survey responses were collected from October 1-31, 2024. The question asked and the 
respondent profile remains unchanged. Size of organization and sector are standardized across all countries and territories to 
allow international comparisons.

About the Survey
The ManpowerGroup Employment Outlook Survey is the most comprehensive, forward-looking employment 
survey of its kind, used globally as a key economic indicator. The Net Employment Outlook is derived by taking the 
percentage of employers anticipating an increase in hiring activity and subtracting from this the percentage of employers 
expecting a decrease in hiring activity. Running since 1962, various factors underpin the success of the Survey:
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Frequently Asked Questions

What is meant by Net Employment Outlook (NEO)?
The Net Employment Outlook is derived by taking the percentage of employers anticipating 
an increase in hiring activity and subtracting from this the percentage of employers that 
expect to see a decrease in employment at their location in the next quarter. A positive Net 
Employment Outlook figure means that, on balance, there are more employers who expect to 
add to their headcount in the following three months than those who intend to reduce staff.

What is Seasonal Adjustment and why is it used in the 
ManpowerGroup Employment Outlook Survey?
Seasonal adjustment is a statistical process that allows the Survey data to be presented 
without the impact of hiring fluctuations that normally occur through the course of the year, 
usually as a result of various external factors, such changes in weather, traditional production 
cycles, and public holidays. Seasonal adjustment has the effect of flattening peaks and 
smoothing troughs in the data to better illustrate underlying employment trends and provide a 
more accurate representation of the ManpowerGroup Employment Outlook Survey results.

How are companies selected for 
the survey?
Employers are selected based on the types of companies and 
organizations they represent. We want to ensure that our panel 
is representative of each participating country’s national labor 
market, so each country’s panel is built in proportion to that 
country’s overall distribution of industry sectors and 
organization sizes.

Who do you interview in each company?
The person we select to interview will be someone with a good 
overview of staffing levels and hiring intentions within their 
organization. Normally this will be the head of HR or an HR 
manager. However, in smaller organizations, that person may 
be a general manager or even the CEO.
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Workforce 
Consulting & 

Analytics

Workforce 
Management

Talent 
Resourcing

Career 
Management

Career 
Transition

Top Talent 
Attraction

Visit www.manpowergroup.com to learn more.

ManpowerGroup Solutions Across the Entire HR Life Cycle

http://www.manpowergroup.com/
http://www.manpowergroup.com/


Appendix
Do not Include in the Report.



Colors in the 2025 MEOS Reports
Do not change graphic or text colors from their 
original state.

– The 2025 MEOS PowerPoint templates use additional 
colors to enhance the overall design. 

– Backgrounds, charts and text colors have been 
purposefully applied and tested for accessibility.

– Do not add new tint shades, standard colors or recent 
colors when localizing the report.



Saving the MEOS Report as a PDF

Exporting your interactive PDF:
– Delete the Appendix (slides 32-36).

– Mac: File > Save a Copy… > File Format > PDF

– PC: File > Save a Copy… > More options > PDF

– Rename and save the document as PDF.

PC

Mac



Industry Vertical & Subsector Icons
Communication

Services
Consumer Goods & 

Services
Energy 

& Utilities
Financial 

& Real Estate
Healthcare 

& Life Sciences
Industrials & 

Materials
Information 
Technology

Transport, Logistics 
& Automotive

Entertainment Food Products Oil, Gas, & 
Consumable Fuels

Banks Healthcare Providers 
& Services

Construction 
& Engineering

IT Services Automotive

Diversified 
Telecommunication 

Services

Food & Staples 
Retailing

Energy Equipment 
& Services

Insurance Pharmaceuticals Industrials 
Manufacturing

Software Road & Rail

Media & Publishing Consumer Goods & 
Services 

Manufacturing

Electric Utilities Real Estate 
Management & 
Development

Healthcare Equipment 
& Supplies

Materials 
Manufacturing

Technology Hardware, 
Storage & Peripherals

Transportation 
Infrastructure

Wireless 
Telecommunication

Hospitality Industry Diversified Financial 
Services

Healthcare Technology Construction Materials Air Freight & Logistics

Multiline Retail Consumer Finance Machinery



Argentina Australia Austria Belgium Brazil Canada Chile

China Colombia Costa Rica Czech 
Republic Finland France Germany

Greece Guatemala Hong Kong Hungary India Ireland Israel

Italy Japan Mexico Norway Panama Peru Poland

Portugal Puerto Rico Romania Singapore Slovakia South
Africa Spain

Sweden Switzerland Taiwan The 
Netherlands Turkey U.K. U.S.

Country Flag Icons Global Average


